THE CITY COUNCIL WOULD LIKE to make the park analysis available to the public. A paper map, such as the one we made in the last lesson, is the traditional way to share results, but online maps are a new way to share your story, methods, and data with the widest possible audience.

With a free public account at ArcGIS Online, you can make web maps that combine Esri basemaps with your own geographic data and a huge number of map services (online layers) that are hosted on the web. You can share your web maps with everyone or with user groups that you set up. You can also publish the maps as web applications to give them a self-contained and professional appearance.

You can use your ArcGIS Online account to store many kinds of geographic items in addition to web maps. For example, you can upload geoprocessing packages, such as the one you made in Lesson 7, that contain models, tools, and data. Likewise, you can upload map and layer packages, which bundle map documents or individual layer files along with their source data. These packages can be shared from your ArcGIS Online account, allowing you to communicate your maps, results, and workflows to others. You can also store shapefiles and text files in CSV format.

In the first exercise in this lesson, we’ll prepare relevant project data for use in the web map. This means converting the data from geodatabase to shapefile format, because shapefiles can be added to a web map. We’ll also outline the steps for setting up your public ArcGIS Online account. We’ll create a web map in the second and third exercises. In the fourth exercise, we’ll publish the map as a web application. This allows users, and nonmappers in particular, to access the map as a self-contained web product (self-contained in much the same way as a PDF file) with a simple, attractive interface. In the final exercise, we’ll upload our geoprocessing package and other files that we want to share at ArcGIS Online.
Prepare analysis results for ArcGIS Online

Make a web map (Part 1)

Make a web map (Part 2)

Publish the map as a web application

Manage ArcGIS Online content

You are here:

✓ Frame problem and explore study area

✓ Preview data

✓ Choose data

✓ Build the database

✓ Edit data

✓ Conduct the analysis

✓ Automate the analysis

✓ Present analysis results

✓ Share results online

What you’ll do in this lesson:
**Exercise 9a: Prepare analysis results for ArcGIS Online**

In this exercise, we’ll choose and prepare the data we want to use in our web map. The web map will be less elaborate than the presentation map from Lesson 8, but it will have some unique advantages: users will be able to navigate the map and open pop-up windows with information and photographs of each site. Once the data is chosen and prepared, we’ll outline the steps of setting up an ArcGIS Public Account. An account isn’t necessary for viewing web maps, but it is required for saving and sharing maps and other online content.

1) **Choose data for the web map.** Like the final map from Lesson 8, the web map will focus on the analysis results and will show mostly the same key layers: the LA River, the ¾ mile buffer that defines the study area, and the recommended sites. We’ll reopen the map from Lesson 6 to get a rough sense of what the web map will look like.

   a. Start ArcMap.
   b. On the ArcMap - Getting Started dialog box, in the list of recent maps, click Lesson 6 to select it and click Open.
   c. If you don’t see Lesson 6, click the Browse for more link under Existing Maps (Figure 9-1), and browse to it in the MapsAndMore folder. (If you don’t have this map document at all, create a new map document instead.)

When the map opens, it should look like Figure 9-2, with the river, the river buffer, and the recommended sites (small at this scale) displayed against a basemap of imagery.
Lesson 9: Share results online

- Expand C:\UGIS\ParkSite\AnalysisData\ReadyData.gdb in the Catalog window.

- Drag Parks to the Table of Contents and drop it under the LARiverBuffer layer (Figure 9-3).

This is the data (but not the symbology) that we want the web map to show: the river, the proximity zone that constrained our search, and the selected sites in relation to existing parks.

2) **Convert geodatabase feature classes to shapefiles.** Although the geodatabase file format has many advantages over the shapefile format, shapefiles have one very nice property: unlike geodatabase feature classes, they can be added to web maps. To prepare the web map data, we need to convert feature classes from the ReadyData geodatabase to shapefiles.

- In the Catalog window, right-click the ParkSite folder and choose New ➔ Folder. Rename the folder ArcGIS Online (Figure 9-4).

- Open the Search window. Click the Tools link, if necessary, to restrict the search to geoprocessing tools.

- In the Search box, type *shapefile* and press Enter.

One of the first results should be a script tool named Feature Class to Shapefile (Conversion) (Figure 9-5).
Open the Feature Class to Shapefile tool.
Open the Catalog window. Expand the AnalysisData folder and the ReadyData geodatabase.
Drag and drop the *LARiver* feature class from the Catalog window onto the Input Features box of the tool.

The feature class, with its entire path name, is added to the list of input features (Figure 9-6).

Again, from ReadyData.gdb, drag and drop *Parks* onto the Input Features box.
The *Parks* feature class is also added to the list.

In the Catalog window, expand the AnalysisOutputs geodatabase.
Drag and drop *LARiverBuffer* to the tool.
Drag and drop *RecommendedSites* to the tool.
In the Catalog window, drag and drop the ArcGIS Online folder you just made onto the Output Folder box.
Check your settings against Figure 9-7 and click OK.

When the tool finishes running, four new shapefiles are created.
In the Catalog window, expand the ArcGIS Online folder to confirm that it contains the shapefiles (Figure 9-8).

Exit ArcMap. Click No on the prompt to save your changes.

3) **Compress the shapefiles as ZIP files.** A shapefile looks like one file in the Catalog window, but is in fact a composite, consisting of at least a geometry file (.shp), an index file (.shx), and an attribute file (.dbf). Most shapefiles also include projection files (.prj), metadata files (.xml), and additional index files. To add a shapefile to a web map, we first have to package its component files in a ZIP file.

Open Windows Explorer and navigate to C:\UGIS\ParkSite\ArcGIS Online.

Each shapefile appears as a collection of files (Figure 9-9).

In Windows Explorer, click `LARiver.dbf` to select it. Hold the Shift key and click `LARiver.shx`.

The seven files that make up the `LARiver` shapefile should be selected.
Right-click any of the selected files and choose Send to ➤ Compressed (zipped) folder (Figure 9-10).

![Figure 9-10](image)

A compressed file named LARiver.zip is created in the same folder. By default, the file name is selected for editing.

Click outside the editable text box to accept the default file name (Figure 9-11).

Follow the same process to zip LARiverBuffer, Parks, and RecommendedSites in turn.

Each shapefile consists of seven files. The first has the file extension DBF and the last has the extension SHX.

Once the four zip files have been created, the data preparation for the web map is done.

### Including multiple shapefiles in a ZIP file

Multiple shapefiles can be compressed in a single ZIP file. We could have selected all twenty-eight component files, put them in one ZIP file, and had this ZIP file ready to add to a web map. Assigning each shapefile to its own ZIP file, as we did, means that each shapefile becomes a single, separate layer in the web map. If a ZIP file contains multiple shapefiles, a single group layer with multiple sublayers is created instead. This isn’t necessarily a disadvantage, but some layer properties in a web map, such as transparency, can be set only at the group layer level and not for individual sublayers.

4) **Create an ArcGIS Public Account.** To save and share web maps and other items at ArcGIS Online, you need to create a free public account.

Open a web browser to www.arcgis.com.

Click the Sign In link in the upper right corner of the page.

If you already have an ArcGIS account (either public or subscription), sign in now with your user name and password.

If you have an Esri Global Account (used for other Esri websites,
such as support and training), you can register this account as an ArcGIS account.

- Click Create a Public Account (Figure 9-12).

- Fill out the form to create a new account, review and accept the terms of use, and click Create My Account.

Your account is created and opens to your profile page (Figure 9-13).

- Click Edit my profile.

Your profile has two purposes. One is to provide information about yourself for the benefit of people who view your maps. The other is to set your language and region. The Language setting localizes the text of the website. The Region setting determines the default opening extent of your maps and affects which maps you see in the gallery.
Optionally, provide a short description of yourself and upload an image.

Choose a language.

Choose a region.

You can choose the appropriate local region or set your region to World.

Click Save (above the thumbnail image).

Your account has been created and you’re ready to make a web map.

**Exercise 9b: Make a web map (Part 1)**

In this exercise, we’ll start a new map and add the shapefile data to it. We’ll choose the basemap we want, symbolize the layers, and set some other layer properties. We’ll also add a Map Notes layer. This is a layer whose features are created within the web map itself, rather than being added from an external file.

1) **Start a web map.** We’ll create a new ArcGIS Online web map.

   a) If necessary, open a web browser to www.arcgis.com. Click the Sign In link in the upper right corner of the page and sign in with your user name and password (Figure 9-14).

   b) At the top of the page, click Map (Figure 9-15).
A new web map opens (Figure 9-16).

A new web map always starts with a topographic basemap zoomed to the extent specified by the Region setting in your profile. (In this example, the region setting is United States.)

2) Add shapefile data. We’ll add the shapefiles we prepared in the previous exercise.

   a) On the ribbon, click the Add drop-down arrow and choose Add Layer from File (Figure 9-17).

   The Add Layer from File dialog box opens.

   The exact appearance of this dialog box and others that interact with files on your computer depends on your browser. For example, in Firefox and Internet Explorer, the Choose File button is called browse. The examples in this exercise reflect the Chrome browser.

   b) In the Add Layer from File dialog box, click Choose File.

   c) Browse, if necessary, to C:\UGIS\ParkSite\ArcGIS Online.

   d) Click LARiver.zip to select it and click Open (Figure 9-18).
Accept the default option to generalize features for web display and click Import Layer.

The *LARiver* layer is added to the map. The map zooms to the extent of the layer (Figure 9-19).

On the ribbon, click the Add drop-down arrow again and choose Add Layer from File.

On the Add Layer from File dialog box, click Choose File.

Click *LARiverBuffer.zip* to select it and click Open.

Accept the option to generalize features and click Import Layer.

The *LARiverBuffer* layer is added to the Contents panel and to the map.

Add *Parks.zip* in the same way.

Add *RecommendedSites.zip*. With this file, click the Keep original features option before you click Import Layer (Figure 9-20).
By default, features are simplified to draw faster in the web browser. But since these features will only be viewed at very large scales (and there are only five of them) we’d like them to be as accurate as possible.

When the last layer has been added, your map and Contents panel should look like Figure 9-21.

3) **Save the map.** We’re ready to start working with the basemap and the map layers, but it’s a good idea to save the map first.

   a. On the ribbon, click the Save drop-down arrow and choose Save.
   b. In the Save Map dialog box, in the Title box, type *Los Angeles River Park Site Analysis* (or any title that you like).
   c. In the Tags box, type parks, rivers, Los Angeles or any other keywords you think might help people find the map.
   d. Press Enter after each tag.
   e. In the Summary box, type *Potential sites for a new park near the Los Angeles River* or something similar.
   f. Compare your settings to Figure 9-22 and click Save Map.
4) **Change the basemap.** The Topographic basemap is a great map for showing both natural and man-made geography. In our case, however, we want map users to be able to examine the appearance of the recommended sites, so we’ll switch to a basemap of imagery.

   A. On the ribbon, click the Basemap button.
   B. On the drop-down palette of basemaps, choose *Imagery with Labels* (Figure 9-23).

The *Imagery with Labels* basemap replaces the *Topographic* basemap.

5) **Rename layers.** We’ll give the layers more complete and meaningful names. Our goal is to make a map that anyone—from GIS analysts to city politicians to members of the public—can appreciate.

   A. In the Contents panel, hover over the *RecommendedSites* layer.

Notice the small drop-down arrow to the right of the layer name.

   B. Click the arrow and choose Rename on the layer properties menu (Figure 9-24).
   C. In the Rename dialog box, replace the name  *RecommendedSites* with *Recommended Site Parcels* (Figure 9-25). Click OK.

   D. In the Contents panel, hover over the *Parks* layer.
   E. Click the arrow and choose Rename.
   F. In the Rename dialog box, change the layer name to *Existing Parks* and click OK.
   G. In the same way, change the *LARiverBuffer* layer name to *Study Area*.
   H. Change the name of the *LARiver* layer to *Los Angeles River*.

In the Contents panel, the renamed layers should look as shown in Figure 9-26.
6) **Change layer order.** As in ArcMap, the order of layers in the Contents panel determines the drawing order on the map. If your layers are currently in a different order from that shown in previous images, make adjustments as needed to the instructions in this step.

- In the Contents panel, hover over the *Los Angeles River* layer.
- Click the arrow and choose Move Up.

The layer moves up one position in the Contents panel.

- Open the layer properties for the *Los Angeles River* layer and choose Move Up again.

The layers should be in the order shown in Figure 9-27.

- Save the map.

7) **Change layer symbology.** We’ll change the default symbology assigned to the layers (purple for lines and semitransparent blue for polygons). Feel free to satisfy your own tastes by choosing symbols other than the ones illustrated here.

- Open the layer properties for the *Study Area* layer and choose Change Symbols.

The side panel changes from Contents to Change Symbols. The current symbology method (a single symbol for all features) is shown, along with the current symbol (Figure 9-28).

- Click the Change Symbol button.
- In the Change Symbol dialog box, scroll through the list of symbols and choose one you like.
- Use the input box or slider to set the color transparency to 50%.
- Use the input box or slider to set the outline width to 1 px (Figure 9-29).
Exercise 9b: Make a web map (Part 1)

1. Click Done.
2. At the bottom of the Change Symbols panel, click Done Changing Symbols.

The new symbol is displayed on the map (Figure 9-30).

1. Open the layer properties for the *Existing Parks* layer and choose Change Symbols.
2. Click the Change Symbol button.
3. In the Change Symbol dialog box, click the Color bar to open a color palette.
4. On the color palette, choose a shade of green you like (Figure 9-31).
5. Confirm the transparency is set to 25%. (Make this setting, if necessary.)
6. Set the outline width to 0 px (Figure 9-32) and click Done.
7. At the bottom of the Change Symbols panel, click Done Changing Symbols.
In the same way, change the symbol for the *Los Angeles River* layer to a bright blue and make it three pixels (px) wide.

2. For the *Recommended Site Parcels* layer, make the color 100 percent transparent. Make the outline color bright red and give it a width of two pixels (Figure 9-33).

3. Open the layer properties for the *Imagery with Labels* layer and choose Transparency.

4. Use the slider to make the basemap about ten percent transparent (Figure 9-34).

5. Click on some white space in the Contents panel to close the transparency slider.

6. Save the map.

Your map should resemble Figure 9-35, perhaps with different symbology.
8) **Add Map Notes.** As we did in Lesson 8, we again face the cartographic challenge that our recommended sites are quite small in relation to the study area. For the sites to be plainly visible at small scales, they need to be represented as points, because point symbols maintain their absolute size as you zoom in and out. In ArcMap, we were able to symbolize the site polygons as if they were points, but we don’t have that option in our web map. Instead, we’ll create a new layer and place a point symbol at each site. Layers that you create in a web map are called Map Notes.

- On the ribbon, click the Add drop-down arrow and choose Add Map Notes.
- In the Add Map Notes dialog box, change the layer name to **Recommended Sites** (Figure 9-36). Accept the default template (Map Notes) and click Create.

![Add Map Notes](image)

A template is a thematic collection of symbols.

The side panel changes from Contents to Add Features.

- In the Add Features panel, click the Stickpin symbol to select it (Figure 9-37).

![Add Features](image)

As you hover over the map, you see the prompt “Click to add a point.”
Zoom in close on one of the recommended sites.

▷ A good technique is to hold the Shift key and drag a box around the site.

When you’re zoomed in to a site, click inside the parcel boundary to add a point (Figure 9-38).

A stickpin symbol is added at the location you clicked on, and a pop-up window opens that allows you to change symbology and add information.

At the bottom of the pop-up window, click Change Symbol.

In the Change Symbol dialog box, click the drop-down arrow and choose Shapes (Figure 9-39).

Scroll down in the box of Shapes symbols and click the red square to select it.

Change the symbol size to 24 pixels (Figure 9-40) and click Done.

On the pop-up window, click Close.

We’ll come back and do more with pop-up windows in the next exercise.

In the Add Features panel, click the Stickpin symbol again to select it.

On the map, zoom out, pan to another recommended site, and zoom in to it.

▷ To zoom out, use the mouse wheel or the slider in the upper left corner of the map.
Click inside the parcel boundary to add a point.

On the pop-up window, click Change Symbol. The Shapes symbols will still be selected in the drop-down list.

In the scrolling box, click the red square to select it.

Change the symbol size to 24 px and click Done.

Close the pop-up window.

Repeat this process for the remaining sites so that each has a 24-pixel red square inside it.

When you’ve added the last point, on the ribbon, click Details. The side panel changes back to Contents.

Open the layer properties for the *Study Area* layer and choose Zoom To. The map zooms to the closest predefined extent that includes the entire LA River buffer. Your map should resemble Figure 9-41.

Save the map.

**9) Set visibility ranges.** We now have two layers representing the recommended sites. *Recommended Site Parcels* shows the actual site boundaries and is useful at large scales. *Recommended Sites* shows the locations as points and is useful at small and medium scales. We don’t really need or want to see both layers at the same time, so we’ll set complementary visibility ranges for them. You may recall that in Exercise 1b we set visibility ranges (which ArcMap calls scale ranges) for park labels and for block groups.
On the Contents panel, open the layer properties for *Recommended Sites* (the Map Notes layer) and choose Set Visibility Range.

In the visibility range window, click the Out farther than drop-down arrow and choose 1:20,000 (Neighborhood) Figure 9-42.

Click some white space in the Contents panel to close the layer properties.

Open the layer properties for *Recommended Site Parcels* and choose Set Visibility Range.

In the visibility range window, click the In closer than drop-down arrow and choose 1:20,000 (Neighborhood) (Figure 9-43).

Click some white space in the Contents panel to close the layer properties.

Zoom in and out on a few recommended sites to test the settings.

At small and medium scales, you should see only the red squares. At large scales you should see only the red polygon outlines.

At very large scales, it would be nice to see the imagery without the semitransparent study area.

Open the layer properties for *Study Area* and choose Set Visibility Range.

In the visibility range window, click the Out farther than drop-down arrow and choose 1:5,000 (Street).
Zoom in to test the setting.

On the Study Area layer properties menu, choose Zoom To.

Save the map.

10) Add bookmarks. We’ll create bookmarks as navigation shortcuts.

Confirm that you’re zoomed to the extent of the Study Area layer.

On the ribbon, click Bookmarks and choose Add Bookmark.

In the text box, type Study Area (Figure 9-44) and press Enter. Leave the Bookmarked places list open.

Zoom in on Site 1.

In the Bookmarked places list, click Add Bookmark.

Type Site 1 and press Enter (Figure 9-45).

Leave the Bookmarked places list open and navigate to Site 2.

With Site 2 centered in the map display, click Add Bookmark.

Name the bookmark Site 2 and press Enter.

In the same way, add bookmarks for Sites 3, 4, and 5.

When you’re finished, close the Bookmarked Places list (Figure 9-46).

At this point, you’re probably still zoomed in to Site 5.

On the ribbon, click Bookmarks and click Study Area to zoom to the Study Area bookmark.
Optionally, test your other bookmarks and return to the Study Area bookmark.

Save the map.

We’re finished with the look of the map and most of the layer property settings. A big piece is still missing, however—the configuration of pop-up windows to provide information about the map features. That will be our main task in the next exercise.

If you are continuing now, leave the web map open.

**Exercise 9c: Make a web map (Part 2)**

In this exercise, we’ll configure pop-up windows for the layers in our web map. Pop-up windows open when you click on a feature and display information about the feature. This information may include attributes, images, charts, and links to websites. Configuration is the process of designing and formatting the pop-up window information the way you want map users to see it.

1) **Open the web map.** If your web map is open from the last exercise, go to Step 2.

   a) Open a web browser to www.arcgis.com.
   b) If necessary, sign in with your user name and password.
   c) At the top of the page, click **My Content** (Figure 9-47).

   ![Figure 9-47](image)
   The web map is listed as an item on your My Content page (Figure 9-48).

   ![Figure 9-48](image)

   d) Click the title of the web map.

   The web map’s item details page opens (Figure 9-49) (as seen on the next page).

   The item details page shows the map’s title, a thumbnail image, and other information about its contents.
Click the thumbnail image to open the map.
Or click the Open button underneath the thumbnail image and choose Open in ArcGIS.com map viewer.

2) Open pop-up windows. When you click a feature in a web map, a pop-up window opens. The pop-up window lists the feature’s attributes, much as the Identify window does in ArcMap.

On the map, click somewhere on the river buffer.

Depending on where you click, at least one pop-up window, and very likely more than one, will open (Figure 9-50).

You may see a pop-up window for the **Recommended Sites** layer (the map notes you added) or for any of the shapefile-based layers (Figure 9-51).

Examples of default pop-up windows for layers in the map. Clockwise from bottom: **Recommended Sites**, **Study Area**, **Recommended Site Parcels**, **Existing Parks**, and **Los Angeles River**.

If a **NAME** field exists in the layer’s attribute table, the pop-up window will use the feature’s name as a title (John Quimby Park, Los Angeles River).
In the pop-up window title bar, click the white arrow to see the other open pop-up windows.

The feature associated with the visible pop-up window is selected on the map.

Close the open pop-up window.

The default pop-up window display—a list of attributes and their values—can be improved on. We may want to alias attribute names, hide certain attributes, and change formatting. In the case of the Recommended Sites layer, which is the main layer of interest, we’ll add pictures and descriptions to the pop-up windows.

3) **Remove pop-up windows for the Study Area layer.** With five feature layers in the map, there are lots of pop-up windows to look at. It will make the map cleaner to turn off those that add little value.

   a. At the top of the side panel, click the Show Contents of Map button 
   b. Open the layer properties for the Study Area layer and choose Show Table.

   The layer attribute table opens at the bottom of the map window (Figure 9-52).

   ![Figure 9-52](image)

   This layer contains just one feature: the dissolved river buffer. This means that no matter where you click on the layer, you’ll always get exactly the same pop-up window information (Figure 9-53).

   ![Figure 9-53](image)

   This information doesn’t really offer much to map users. In fact, this particular pop-up window is probably more of a nuisance than anything else.

   c. Close the table by clicking the X in the upper right-corner.
   d. Open the layer properties for the Study Area layer and choose Remove Pop-up.
   e. Zoom in close on a part of the study area where there aren’t any other features to click on.
   f. Click on the river buffer to confirm that no pop-up window opens.
   g. Zoom to the Study Area bookmark.
4) **Configure pop-up windows for the *Existing Parks* layer.** The pop-up windows for the *Existing Parks* layer look like the example in Figure 9-54. It’s pretty good, but we’ll hide the FID attribute, which is of no interest. We’ll also make some minor formatting changes so the attribute names aren’t all capital letters and the ACRES field doesn’t show decimal places.

![Figure 9-54](image-url)

---

- Open the layer properties for the *Existing Parks* layer and choose Configure Pop-up.

  The side panel changes to Pop-up Properties.

- On the Pop-up Properties panel, click Configure Attributes (Figure 9-55).

  The Configure Attributes dialog box opens (Figure 9-56).

![Figure 9-55](image-url)

- In the Display column, uncheck the box next to the {FID} field name.

- In the Field Alias column, click in the box with the value NAME.
The box becomes an editable text box.

1. Replace the value NAME with **Name** and press Enter.

2. Click the value TYPE in the Field Alias column. Replace it with **Type** and press Enter.

3. Replace the value ACRES with **Acres**. Press Enter.

4. On the right side of the dialog box, click the Format drop-down arrow and choose 0 decimal places.

5. Compare your Configure Attributes dialog box to **Figure 9-57** and click OK.

![Figure 9-57](image)

6. At the bottom of the Pop-Up Properties panel, click **Save Pop-up**.

7. On the map, click a park feature (**Figure 9-58**).

![Figure 9-58](image)

The pop-up window reflects your formatting changes.
Click a couple of other parks and close the open pop-up window.

Save the map.

5) **Configure pop-up windows for the Los Angeles River layer.**

The pop-up window for the *Los Angeles River* layer looks like Figure 9-59. In this layer, the only useful piece of information is the name of the river, which appears as the title. All we need to do is hide the attributes.

- Open the layer properties for the *Los Angeles River* layer and choose Configure Pop-up.

At the top of the Pop-up Properties panel, the Pop-up Title box is set to the {NAME} field (Figure 9-60).

The field name, enclosed in curly brackets, works like a variable: the name of the feature you click on will appear in the pop-up window title. (In this case, there’s just one feature and therefore just one value.)

- Under Pop-up Contents, click the Display drop-down arrow and choose No attribute information (Figure 9-61).

- At the bottom of the Pop-Up Properties panel, click Save Pop-up.

You may open more than one pop-up window. For example, you may see a pop-up window for a park.

- If necessary, click the white arrow in the title bar of open pop-up windows until you see the pop-up window for the *Los Angeles River* (Figure 9-62).
The pop-up window reflects the new formatting.

- Close the pop-up window and save the map.

6) Configure pop-up windows for the **Recommended Site Parcels layer**. The pop-up window for the **Recommended Site Parcels** layer looks like the example in **Figure 9-63**. A lot of important information is shown, but we have to do some work to make the field names meaningful.

- Open the layer properties for the **Recommended Site Parcels** layer and choose Configure Pop-up.
- In the Pop-up Title box, type **Site** and press the spacebar.
- To the right of the box, click the Add Field Name button [ ].

A scrolling box of all the fields in the layer opens.

- Scroll to the bottom of the box and click SiteID {SiteID}.

The Pop-up Title box should look like **Figure 9-64**.

> **Figure 9-64**

```
Pop-up Title
Site {SiteID} [ ]

Pop-up Contents
```

The word “Site” will be followed in the pop-up window title by the site number (1 to 5), which is stored in the SITEID field.

---

### Field names and aliases

Every field has both a name and an alias. Field names must meet certain requirements (such as not having spaces), while aliases can be more descriptive and natural. In the Add Field Name box, you see both. The alias is followed by the field name in curly brackets, like this: SiteID {SiteID}. By default, the field alias and the name are the same. You can change field aliases on the Configure Attributes dialog box. You can’t change field names.

- Click Configure Attributes.
- On the Configure Attributes dialog box, in the Display column, uncheck the boxes next to the {FID} field name at the top and the {SITEID} field name at the bottom.
- In the Field Alias column, click in the box with the value ACRES. Change the alias to **Acres** and press Enter.
On the right side of the dialog box, click the Format drop-down arrow and choose 1 decimal place (Figure 9-65).

Change other field aliases and formats as shown below:

<table>
<thead>
<tr>
<th>Default field alias</th>
<th>Change to</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>NEAR_DIST</td>
<td>Distance to river (feet)</td>
<td>Zero decimal places</td>
</tr>
<tr>
<td>POP2010</td>
<td>2010 Population</td>
<td></td>
</tr>
<tr>
<td>MEDHINC</td>
<td>Median Household Income</td>
<td></td>
</tr>
<tr>
<td>POPDENSITY</td>
<td>Pop Density (per sq mile)</td>
<td>Zero decimal places</td>
</tr>
<tr>
<td>PCTUNDER18</td>
<td>Percentage of Children</td>
<td>Zero decimal places</td>
</tr>
</tbody>
</table>

In the Field Name column, click in the box with the value \{MEDHINC\} to highlight the row.

By default, the fields appear in alphabetical order, but it will be nice to have the three population attributes next to each other in the pop-up window.

Click the down arrow button twice to move this field below the \{PCTUNDER18\} field.

Compare your Configure Attributes dialog box to Figure 9-66 and click OK.
At the bottom of the Pop-Up Properties panel, click Save Pop-up.

On the map, zoom in close on a recommended site so you see its polygon boundary.

Click on the site to open its pop-up window (Figure 9-67).

If you see anything you want to change, open the pop-up properties for the layer and make edits.

Optionally, use bookmarks to zoom in on some of the other sites and open their pop-up windows.

Close the open pop-up window and zoom to the Study Area bookmark.

Save the map.

7) **Edit a pop-up window for the Recommended Sites layer.** The pop-up window for the Recommended Sites layer looks like the example in Figure 9-68. Map notes share some properties with layers based on shapefiles, but they are manipulated on a more individual basis. You may recall from the last exercise, for example, that we had to set symbology independently for all five sites. In the same way, we’ll configure their pop-up windows on a one-by-one basis.
We don’t want to repeat the site measurements and demographic attributes. Instead, we’ll briefly describe our impressions of each site and add a picture from a visit.

1. Open a new browser tab or window to http://ugis.esri.com/ugis2_images/Gallery/ (Figure 9-69). Keep this browser tab or window open.

2. In your browser, make the tab with the web map active.
3. Click the red square representing Site 1 (the site farthest east). On the pop-up window, click Edit (Figure 9-70).
4. In the pop-up window Title box, replace the default name (Point) with Site 1.
In the Description box, type (or copy and paste) this text or a description of your own: *This site is steep and hilly, better for hikers than for moms with strollers. There’s a nice view to the south. Street access and parking could be a problem.*

In your browser, make the Lesson 9 Images tab active.

In the top row, click one of the images to enlarge it (Figure 9-71).

The caption identifies the site by number.

Use the navigation tools above the image to look at the other Site 1 images.

When you’ve decided which image to use, right-click the image and choose Copy image URL (Figure 9-72).

Be sure to copy the image URL, not the image itself.
Exercise 9c: Make a web map (Part 2)

In your browser, make the tab with the web map active.

In the pop-up window, in the Image URL field, delete the default stub URL (http://) and press CTRL+V to paste the image URL.

Compare your pop-up window to Figure 9-73 and click Close.

Now we’ll test the pop-up window to see how it looks.

On the ribbon, click the Details button to leave Edit mode.

On the map, click the red square for Site 1 (Figure 9-74).

Your pop-up window may have a different picture or description, but should look basically similar.

If you’re happy with the result, close the pop-up window.

If you want to make further changes, click the Edit button at the bottom of the window to return to Edit mode.

Save the map.

Copying image URLs in different browsers

The example above uses the Google Chrome browser. In Mozilla Firefox, the equivalent command is Copy Image Location and in Opera it is Copy Image Address. In Internet Explorer 9, you need to right-click the image and choose Properties. On the Properties dialog box, highlight the URL in the Address field and copy it with CTRL+C.
8) **Edit the other pop-up windows.** Follow the same process to edit the pop-up windows for the four remaining sites. The steps are summarized below. You can make up your own descriptions or use the ones in Figure 9-75.

<table>
<thead>
<tr>
<th>SITE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site 2</td>
<td>This site is right by the river at a stretch of natural river bottom. It’s the only site that really makes you aware of the river’s presence. A drawback is proximity to the Glendale Freeway.</td>
</tr>
<tr>
<td>Site 3</td>
<td>This site has nice views of mountains to the north and Griffith Park to the west. A drawback is that train tracks run right along the eastern edge of the lot.</td>
</tr>
<tr>
<td>Site 4</td>
<td>This site is close to schools and the Orange Line metro. Its odd U-shape (visible if you zoom in) comes from being made up of three connected parcels. The westernmost of these could make a 1.2-acre park by itself.</td>
</tr>
<tr>
<td>Site 5</td>
<td>This site is pretty far from the LA River, but it’s very close to Aliso Canyon Wash, which feeds into the river. The site is also easy to reach from major streets.</td>
</tr>
</tbody>
</table>

- Click the red square that symbolizes a site.
- On the pop-up window, click Edit.
- Replace the default title with the site number (for example, “Site 2”).
- Type a description.
- Go to the Lesson 9 Images tab. Choose an image (a large version, not a thumbnail) and copy the image URL.
- In your browser, go back to your web map and paste the URL into the Image URL box.
- Close the pop-up window.
- On the ribbon, click the Details button to leave Edit mode. Click the site again to see how the pop-up window looks.
- Save the map.

9) **Fill out item details and share the map.** Your web map is finished. After you fill out any missing item details, you’ll be ready to share it.

- If necessary, at the top of the side panel, click the About this Map button (Figure 9-76).
- On the side panel, click More Details.
  The map’s item details page opens.
- On the item details page, click the Edit button (Figure 9-77).
The map already has a title, summary, and tags from when you saved it in the previous exercise. It also has a default thumbnail image captured by ArcGIS Online.

In the Description box, type the following description, or any description you think is appropriate. You can use the Bullet List button or any other tools on the Description toolbar:

This map shows the results of a GIS analysis to find suitable sites for a new park near the Los Angeles River. Recommended sites meet these conditions:

- On a vacant land parcel at least one acre in size
- Within the Los Angeles city limits
- Within 3/4 mile of the LA River
- More than 1/4 mile from existing parks
- In a high-density, lower-income neighborhood with a high percentage of children

In the Access and Use Constraints box, type None.

Under Properties, in the Credits box, type: City of Los Angeles Department of Public Works - Bureau of Engineering.

At the bottom of the page, click Save.

Near the top of the page, next to Edit, click Share.

On the Share dialog box, click Everyone (public) (Figure 9-78). Click OK.

Anyone can now find your map by typing relevant keywords, such as “Los Angeles River,” in the Find Maps box.

Click the Open drop-down button and choose Open in ArcGIS.com map viewer (Figure 9-79).

You can also click the map’s thumbnail image.
The map reopens.

4 On the ribbon, click the Share button (Figure 9-80).

Figure 9-80

The Share dialog box appears.

On the Share dialog box, click Close.

Exercise 9d: Publish the map as a web application

In this exercise, we’ll publish the web map as a web application. A web application is a template that gives your web map a simple, attractive interface. When you make the web application, both items—the map and the app—remain available at ArcGIS Online.

1) Open the web map. If your web map is open from the last exercise, go to Step 2.

   a Open a web browser to www.arcgis.com.
   b If necessary, sign in with your user name and password.
   c At the top of the page, click My Content.
The web map is an item on your My Content page (Figure 9-81).

1. Click the web map's title to open its item details (Figure 9-82).
2. Click the thumbnail image to open the map.

2) **Make a web application.** There are several web map application templates to choose from. We’ll preview one of the templates, then save the map to it.

   a. On the ribbon, click the Share button.
   As long as the map is shared, the Make a Web Application button will be enabled on the Share dialog box.
   b. Click Make a Web Application.
   On the Share dialog box, you see a selection of templates, each with its own name and thumbnail image.
   c. Click the one in the upper right of the first page named Basic Viewer (Figure 9-83).
Under the thumbnail image of the template, click the Publish drop-down arrow and choose Preview.

A new browser tab or window opens, showing you how the web application looks in its default configuration (Figure 9-84).

The map user can pan and zoom and has access to several other tools for interacting with the map. For our audience of nonmappers—whether from the city council or the general public—we will limit the number of these additional functions in the configuration step.

On the preview, click a map feature.

The pop-up windows work just as they do in the web map.

Close the open pop-up window.

Close the browser tab with the template preview.

It’s easy to preview templates, so you may want to come back later and try some others. For now, we’ll go ahead and publish the map in the One Pane template.

Under the thumbnail image, click the Publish drop-down arrow and choose Publish (Figure 9-85).

Now you need to fill out some basic information to save the web application, just as you did with the web map.

On the Share dialog box, in the Title box, type: Los Angeles River Park Site Analysis.

This is also the name of your web map, which is okay: they’re basically two versions of the same thing. Both items will turn up in search results, differentiated by their item type. (If you want to give the web application a different name, that’s fine, too.)
The tags and summary should already be populated.

1. Confirm that your Share dialog box looks like Figure 9-86; then click Save & Publish.

2. On the Share dialog box, click the link to go to the item now (Figure 9-87).

This takes you to the web application’s item details page (Figure 9-88).

If you accidentally click Close on the Share dialog box, you’ll return to the web map. That’s fine. From the web map, above the ribbon, click the My Content drop-down arrow and choose My Content. On your My Content page, click the title of the web mapping application to open its item details.
3) **Configure the web application.** Some web application templates allow more configuration than others. The One Panel template has just two properties you can change: the color scheme and the text that identifies the map owner.

   a. Click the Configure App button.

   The web application displays on the left. In the panel on the right are some settings you can change.

   b. Under general Settings, in the Title Text box, type a name you want the map to show.

   c. Optionally, click the Color Scheme drop-down arrow and choose another color scheme and click Save.

   d. Under menu Items, uncheck everything except Legend, Details, Bookmarks, and Measure (Figure 9-89).

   That will present a less confusing user interface, but there’s no true correct way, so include the Menu Items that you want.

   e. When you’re satisfied, click Save.

   f. Click the Go Back button on your browser to go back to the item details page.

   g. On the item details page, click the Open button and choose View Application.

   Your changes are reflected in the map window.

   The web application opens in a new browser tab or window (Figure 9-90).
The web application and the web map

The web application remains closely connected to the web map from which it was published. Any changes you make to the web map—such as adding or removing layers, changing symbology, or configuring pop-up windows—will be reflected in the web application. The same is true for changes to the web map’s item details. Any configurable properties of the web application, however, are independent of the web map.

The availability of the web application also depends on the availability of the web map. If you delete the web map or stop sharing it, the web application will become unavailable.

4) Fill out item details and share the web application. In the last exercise, you added metadata and set sharing properties for the web map. You need to do the same for the web application.

A Go to the browser tab or window that shows the item details page for the web application.
▷ Leave the web application open.

B On the item details page, click the Edit button.

C In the Description box, type (or copy and paste) the following description or a description of your own:

This map shows the results of a GIS analysis to find suitable sites for a new park near the Los Angeles River.

D In the Access and Use Constraints box, type None.

E Under Properties, optionally add some more tags.

F In the Credits box, type City of Los Angeles Department of Public Works - Bureau of Engineering.

G Click Save.

H Near the top of the page, click Share.

I On the Share dialog box, click Everyone (public) and click OK.
▷ Leave the item details page open.

5) Replace the default thumbnail image. Every web application has the same generic thumbnail image by default. Unlike web map thumbnails, these images are not automatically updated by ArcGIS Online. If you want an image that reflects your application, you need to capture it yourself. The following steps describe the process using the Microsoft Paint utility in Windows 7. (If your operating system is different, you will need to make appropriate adjustments.) Of course, you can use any image editing software you like instead.

A Click the browser tab that shows the web application.

B On your keyboard, press Print Screen.
An image of the screen is captured to your clipboard.

1. Click the Windows Start button, then choose All Programs ➔ Accessories ➔ Paint.
2. In the Paint application, in the Clipboard group, click the Paste button (Figure 9-91).

The screen image is pasted in the Paint window. The image will be easier to crop if you make it smaller.

3. In the Image group, click Resize.
4. In the Resize and Skew dialog box, in the Resize area, change the horizontal value to 50.
5. Confirm the Resize By option is set to Percentage and the Maintain Aspect Ratio box is checked (Figure 9-92). Click OK.

6. In the Image group, click the Select drop-down arrow and choose the Rectangular selection tool.
7. Drag a selection box around just the part of the image you want to keep (excluding the browser toolbars, and so on). In the Image group, click Crop.
8. In the Image group, click Resize.
9. In the Resize and Skew dialog box, change the Resize By option to Pixels. Set the Horizontal value to 200 (Figure 9-93) and click OK.
In the Paint application title bar, above the ribbon, click the Save button.

In the Save As dialog box, accept the default location or browse to the location you want.

Type a name for the file, such as LARiverWebAppThumbnail. If necessary, set the Save as type to PNG (*.png) (Figure 9-94).

Click Save.

Go back to the web application’s item details page.

On the item details page, click the Edit button.

Click the thumbnail image to change it.

On the Upload Thumbnail dialog box, click the Choose File button (or the equivalent button in your browser).

Browse to the folder where you saved the image. Click the image to select it and click Open.

Click OK on the Upload Thumbnail dialog box.

You won’t see the image yet.

On the item details page, click Save.

The new thumbnail image appears (Figure 9-95). Anyone who finds your web application in a search on ArcGIS Online will see this thumbnail image in search the results and elsewhere.

Close the browser tab that shows the web application.

If you are continuing now, leave the browser tab open that shows the item details page.
That completes our work with web maps and applications. In the last exercise, we’ll upload the geoprocessing package we made in Lesson 7 so we can share it with others at ArcGIS Online. We’ll also make a map package from our final map in Lesson 8 and upload that as well.

### Take the LA River Map Tour

The Los Angeles River Map Tour (http://ugis.esri.com/LA_River_Tour) is a web mapping application that presents a series of images alongside a map of the river and the image locations. The application uses the Map Tour template, which is available from the ArcGIS Online site only with a paid subscription. However, from the Esri Storytelling with Maps site at http://storymaps.esri.com/templategallery, the same template can be downloaded. With the downloaded template, you can create a map tour web application and host it on your own web page.

### Exercise 9e: Manage ArcGIS Online content

In this exercise, we’ll upload the geoprocessing package we made in Lesson 7. That package contains both the model and the data needed to run it. By sharing the package, we can make it available to other interested people who may want to adapt it to their own purposes or help us refine it. We’ll also create and upload a map package. Just as a geoprocessing package contains tools (including models) and data, a map package contains a map document, its layers, and the datasets referenced by those layers.

1) **Go to your My Content page.** If your ArcGIS Online account is still open from the last exercise (probably to the item details page of your web application), skip to Step 1C.

   - Open a web browser to www.arcgis.com.
   - If necessary, sign in with your user name and password.
   - At the top of the page, click My Content.

2) **Upload the geoprocessing package.** In Exercise 7e, after creating and documenting the analysis model, you made a geoprocessing package and saved it to your MapsAndMore folder. Now you’ll upload that file to ArcGIS Online.

   - On your My Content page, click Add Item.
   - In the Add Item dialog box, confirm that the drop-down list for the item’s location is set to On my computer.
Click the Choose File button (or the equivalent button in your browser) and browse to C:\UGIS\ParkSite\MapsAndMore.

Click ParkSuitabilityAnalysis.gpk to select it (Figure 9-96) and click Open.

If you don’t have this file, download the Lesson 7 results from the Understanding GIS website. Extract the contents and copy the ParkSuitabilityAnalysis.gpk file to your MapsAndMore folder.

On the Add Item dialog box, the file name is now the item’s title.

In the Tags box, type the following tags or a similar set: parks, rivers, Los Angeles, site selection, geoprocessing, models.

Press Enter after each tag.

Confirm that the Add Item dialog box looks like Figure 9-97; then click Add Item.

It may take a few moments for the package to upload. When it does, you’re taken to its item details page (Figure 9-98).

The item details page has a default thumbnail image. The summary and description come from the description of the model that you entered in the model properties in Exercise 7a.
3) **Edit item details and share the package.** We’ll make a couple of minor edits to the item details, consider some optional edits, and share the package.

- On the item details page, click the Edit button.
- In the Title box, edit the title by adding spaces so that it reads **Park Suitability Analysis**.
- In the Access and Use Constraints box, type **None**.
- Optionally, add more detail to the description.

For example, you might want to summarize the inputs, processes, and outputs. You might also want to add a hyperlink to your web map.

- Optionally, create and upload a thumbnail image that reflects your model.

Detailed steps for replacing a thumbnail image are given in Exercise 9d. **Figure 9-99** shows how the page might look after editing, but you don’t need to spend more time on this work than you want to.

**Figure 9-99**

![Park Suitability Analysis](image)

**Description**

This model identifies vacant parcels near the Los Angeles River that may be suitable for a new park.

- Geoprocessing Package by YourName
- Last Modified: August 13, 2013
- (0 ratings, 0 views)
- Facebook Twitter

**This box must be checked on the Search Results page for the geoprocessing package for the package to be found.**

- When you’re finished editing the item details, click Save.
- Click Share.
- On the Share dialog box, check the box to share the item with Everyone (public) and click OK.

Users can now find your geoprocessing package at ArcGIS Online. They can only find it, however, if their search results are set to Show ArcGIS Desktop Content (**Figure 9-100**). If this box is unchecked, search results will return web maps and web applications, but not packages or other items.

When a user finds your package, they can choose either to open it immediately in ArcGIS 10.1 for Desktop or download it and use it later.
Exercise 9e: Manage ArcGIS Online content

The geoprocessing package

When a user opens the Park Suitability Analysis geoprocessing package—for example, by dragging and dropping it on the ArcMap window or by double-clicking it—several things happen:

• An ArcMap document opens. The Table of Contents shows the layers created by the execution of the tool. (This package was created from the second run of the model, where the buffer value for the LA River was 0.25 miles and only one site was found.)

• A Results window opens (Figure 9-101). The window contains a geoprocessing result file called ParkSuitabilityAnalysis. The result file contains the model tool, its output data, input settings, environment settings, and messages.

• The complete geoprocessing package contents are saved to your user profile location. (For Windows 7 users, this is C:\Users\<username>\My Documents\ArcGIS\Packages.) The contents include the model, the geodatabases holding input and output data, a toolbox containing the model as a geoprocessing tool, and the geoprocessing result file mentioned above (Figure 9-102) (next page).

Users can rerun the model as a tool with the same or different parameters, edit the model in the model window, replace the input data with their own data, and, in general, use the model in any way they like.

Geoprocessing packages cannot be created or used with earlier software versions than ArcGIS 10.1 for Desktop.

Figure 9-101

Users can open the model as a geoprocessing tool to change parameter settings.

Or edit the model in the Model window.

Or rerun the model with its current settings.
4) **Create and share a map package.** Just as a geoprocessing package can be used to share tools and data, so a map package can be used to share map documents and the data they reference. Your web map and web application have the great advantage of being accessible to anyone with an Internet connection, but they’re not as detailed or cartographically rich as the map you made in Lesson 8. In this exercise, you’ll make a map package from your final desktop map and upload it to ArcGIS Online.

- Start ArcMap with a blank map.
- Expand the C:\UGIS\ParkSite\AnalysisData folder in the Catalog window.
In the Catalog window, drag Lesson8.mxd into the ArcMap window (Figure 9-103).

Map packages require that the map document have some basic metadata: a summary, description, and tags. You probably added that information in Lesson 8a (at the end of Step 3). If you provided only minimal information, you may want to add more detail; if the fields are blank, you can fill them in now.

From the main menu, choose File ➤ Map Document Properties.

Confirm that the Summary, Description, and Tags fields are populated (Figure 9-104).

Optionally, edit these fields to add more information and click OK.

If you made any edits, save the map document.

From the main menu, choose File ➤ Share As ➤ Map Package.

On the Map Package dialog box, if necessary, click the option to Upload package to my ArcGIS Online account.
Replace the default name (Lesson 8) with **Potential LA River Park Site Locations** (Figure 9-105).

1. In the side panel, click Item Description.
   You can see that the required metadata is present.

2. In the side panel, click Additional Files.

3. On the Additional Files window, click the browse button and browse to C:\UGIS\ParkSite\MapsAndMore.

4. Click **DataRequirementsTable.doc** to select it (Figure 9-106) and click Open.

   This document has some background information about the site selection criteria that may be of interest.

5. In the side panel, click Sharing.

6. On the ArcGIS Online Sign In screen, enter the user name and password of your ArcGIS Online account and click Sign In.

   You may be signed in to ArcGIS Online through your browser, but you also have to sign in through ArcMap to upload the map package.
On the Sharing window, check the box to share your package with Everyone (public) (Figure 9-107).

In the upper right corner of the Map Package dialog box, click Analyze.

A Prepare window opens in ArcMap to show any problems (Figure 9-108). You saw this window once before in Exercise 7e (Step 5), when you created the geoprocessing package. Once again, there should be no problems to resolve.

In the upper right corner of the Map Package dialog box, next to the Analyze button, click Share.

- If you get a message that the map document has changed and needs to be saved, click Yes.

The map package is prepared and uploaded. When it’s done, you’ll get a message that the operation was successful (Figure 9-109).

- Click OK on the Succeeded message.

- Exit ArcMap.

5) View the map package item details. The map package is already shared publicly. We’ll look at the item details to see if they need editing.

- Make your web browser with ArcGIS Online active.

- If necessary, open a web browser to www.arcgis.com and sign in with your user name and password.
In ArcGIS Online, go to your My Content page.

The map package should be listed along with your other items (Figure 9-110).

Click the title of the map package to open its item details (Figure 9-111).

The item details look good. The title, summary, description, and tags match the map document properties, and the thumbnail image shows the map. If you want, you can put a value in the Access and Use Constraints; apart from that, there's nothing more to do.
6) **Review your ArcGIS Online profile.** When ArcGIS Online users find your items, they will be able to view your profile. When you created your account in Exercise 9a (Step 4), you had an opportunity to customize your profile. If you didn’t do it then, you may want to do it now. People are more likely to trust and use your maps and packages if they know who you are and how to contact you.
In ArcGIS Online, above the ribbon, click your name and choose My Profile (Figure 9-113).

Confirm that everyone can see your profile.

If you haven’t uploaded a picture or added information about yourself, click Edit my profile.

In the box, type something about yourself, such as where you work or study, what your interests are, and how others can contact you about your maps.

Click the generic thumbnail image and upload a picture.

Click Save.

That brings us to the end of the book. Our main goal has been to guide you through the steps of a typical GIS analysis problem. Not all problems are the same, but hopefully we’ve shown you practices and approaches that can be applied to the next project that comes your way. Our second goal has been to introduce you to ArcGIS 10.1 for Desktop software. And our third goal, more important in this second edition of the book than in the first, has been to show you some of the capabilities of ArcGIS Online, a rapidly developing part of the ArcGIS platform. In planning this book, we made a decision to use the software only insofar as it served the needs of the project. We tried to make the project complex enough that it would use a lot of functionality, but of course there was a lot that we didn’t do. Keep exploring the software on your own until the trial license period expires. Keep your ArcGIS Online account active and keep making web maps. And for any questions or concerns about the book itself, visit our website at pro.arcgis.com/understanding-gis.